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Welcome to ICAP/4, Intusoft’s suite of analog and mixed-signal simulation products.  If you are 
using ICAP/4’s demo CD, it premieres many of ICAP/4’s capabilities, but you are limited in the 
component model count and a few capabilities.  Within the demo CD, more than 1,450 models are 
provided from ICAP’s collection of 23,500 parts, plus advanced analyses such as Monte Carlo 
statistical analysis, Magnetics Designer transformer and inductor design option, design optimizer, 
and component parametric sweeping. 
 
Let’s get started and test drive ICAP/4. This short guide will enable you to view an existing circuit 
drawing, enter a new drawing, set up a design simulation, view signal waveforms, modify your design 
until satisfied with its operation, and configure the windows environment to modify and save the way 
application windows come to view each design session.  See if you agree that ICAP/4 is today’s best 
and most powerful analog and mixed-signal offering.  Intusoft guarantees this by providing a 30-day 
money back policy on all of its software, except for ICAP/4 Consumer. 
 

1) Notes: The word “click” or “double click” implies pressing the left mouse button 
accordingly, unless stated as the right button. If you ever lose sight of the schematic, 
simulation, or waveform-display windows, simply left-click the mouse on their 
corresponding "icon" boxes at the bottom of your desktop to bring them to view. The boxes 
will be labeled "SpiceNet" for the schematic; "IsSpice4" for simulation windows including 
real-time marching waveforms, output file and error file; and "IntuScope," the full 
waveform-viewing tool. Resizing these windows so they come to view this way each time 
is covered in Step 12.  In the extremely unlikely event that any of ICAP/4’s programs go 
awry, invoke the “Icaps” icon at the bottom of the desktop toolbar and “Exit Icaps.”   

 
2) Select the “Start” box at the bottom left corner of your computer’s desktop.  Select 

“Programs,” “ICAP_4 Demo,” and “Start ICAPS.”  This brings to view the ICAP/4 
schematic and simulation environment, all in an integrated window shell labeled, 
“SpiceNet” in the banner.  Next, select from the “File” pulldown, “Open.”  Browse to 
C:\spice8d\Circuits\PowerDemo\FlybkTemplate” and double-click on the 
FlybackTemplateDemo.DWG file. This brings the drawing to view.  Next, go the middle of 
the top toolbar and you will see a small white window.  Pulldown from its arrow and select 
“avg.”  This illustrates the top level of a Flyback SMPS power supply design. The 
schematic is comprised of several circuit layers, all visible in this drawing. You can scroll 
around the design by using the window’s scroll bars, or by holding down the left mouse 
button on a blank area of the drawing and dragging the mouse in a desired direction. You 
can zoom in or out by first left-clicking on an area of interest on the drawing, then pressing 
the <F7> or <F8> keys. You can also left click the zoom icon on the right toolbar 
(magnifying glass), then hold down the left mouse button and drag around an area you want 
zoomed on the schematic, then release the mouse button. The <F6> key will fit the drawing 
within the schematic window.  Finally, holding the Ctrl key while moving your mouse 
roller up or down (if equipped with a roller) will zoom in or out. 

 
Note that the actual schematic window resides inside the “SpiceNet” outer shell window.  
For schematic resizing to work as intended above (i.e., F6, F7 and F8 keys), the inside 
schematic window should first be brought to full size within the outer SpiceNet shell 
window (if necessary) by pressing the inside schematic window’s “maximize” icon.  Let’s 
next look at another schematic layer that is part of this design. 

 



3) Hold down the left mouse button for a moment inside the op-amp located in the lower left area of 
the design.  A gray shadow box appears around the op-amp. Briefly hold the left mouse button 
down on the “eye-looking” icon in the bottom toolbar of the screen (left). The corresponding 
layer of the design highlights in pink and its name (Subsckt) is indicated to the left of the eye. 
Using SpiceNet’s powerful layering system, a designer can begin creating a particular 
schematic layer, such as the one you highlighted, then add on other circuit portions in new 
layers. Wiring between layers is easy because visibility between all layers is maintained 
during the wiring process.  Configurations (Options pulldown, “Configurations,” “Edit”) save 
designs as different revisions and enable instant reuse or modification to the circuitry.  

   
4) Next let’s observe a sub drawing under a high-level component from the Avg design 

hierarchy.  Right-click inside the “FLYBACK_ID” component toward the top of the 
design, then select “Push into subdrawing.”  The detailed design that resides under this 
component is now illustrated.  Close this drawing by left-clicking the mouse on the “close” 
icon on the top right of the drawing’s banner. 

 
5) Let’s pull down another circuit within the design hierarchy from the small white 

configuration window used previously.  Select, “AvgSubckt.”  Copy a component from 
within this design and connect the new part back in with wires. For example, select a 
resistor and hold down the left mouse button over it until it is highlighted.  Release the 
mouse. Press the <CTRL C> keys to copy the resistor. Left click the mouse on the 
schematic where you desire the component to be placed, then press the <CTRL V> keys to 
paste it. As an alternative, you can hold the left mouse button down and drag a boundary 
box around the resistor, or any group of circuitry, and copy/paste using the previous steps.  
In this process, you may have unintentionally encompassed wires alongside the moved 
part(s).  This is no problem because you can use them in connecting the parts into the 
schematic. Or, you can area-select a wire(s) and press the <Backspace> key to delete.  Also, 
the <Ctrl Z> keys delete any steps you’ve taken, one step each time indefinitely. Finally, 
click on the second icon from the top of the far right toolbar.  This brings up a wiring 
cursor.  Simply hold down the left mouse button and drag the wire pencil from the desired 
beginning point (i.e., component leg) to an end destination such as another component or 
wire in the existing circuit.  To exit this “wiring mode,” select the top icon on the right 
toolbar or simply press the <Esc> key. 

 
6) If you double click on any component, its parametric information is revealed in a 

“Component Properties” dialog box. The selections within this box enable you to ascribe or 
change component values and parameters. Double click the resistor you placed (or any 
resistor) and observe the second entry in its Properties dialog box.  There lies its current 
value.  It should be highlighted, so to change it, press the <Backspace> key and type in a new 
value.  Try changing other values that are permissible.  To exit, press the “OK” button to save 
changes, or the “Cancel” button to ignore them. 

 
Double click on voltage source (V2) toward the bottom mid-schematic. Double-click on 
“Pulse” next to “TRAN Generators” toward the middle of the Component Properties dialog 
box. Observe its specifications, then select some of the tabs on top to see different input 
waveforms for construction.  Close all dialog boxes by pressing their “Cancel” button.  Note 
that 30 types of signal generators are available from the “iGenerators” Part-Type field inside 
SpiceNet’s parts browser (just press the <x> key to bring it to view). Finally, right click on a 
component and note with many of the menu items listed, if selected, a "help" button is 
furnished inside their dialog box. Along these lines, left click on the context-sensitive help 
icon (black question mark) on SpiceNet’s top toolbar. Then, select any of the menu items 
from SpiceNet’s toolbars, and left-click on a desired function. Help for that selection will 
come to view for most items. Note selecting an entity directly on the schematic with the black 
question mark will invoke general SpiceNet help. 



7) Let’s place a new component onto the design. Select the "Parts" pulldown from the top 
menus. "Passive" and "Active" are chosen for generic parts, which contain no specific part 
number information. Notice that resistors and capacitors (common electronic components) lie 
in the "passive" menu. Real parts with a part number, or specialized components, are chosen 
from SpiceNet’s "Parts Browser," which is positioned as the initial selection from this "Parts" 
pulldown. Select this and a dialog box will come to view showing all the types of part 
categories. Left-click any of the "Part Types" and observe corresponding selections in the 
"Sub Type" window. Then, specify any component from the "Part List" window. Finally, 
select the "Place" button. Alternatively, you can use the "Parts Browser" icon on the top 
toolbar, which looks like an open book, or simply push the <x> key on the keyboard. Re-
invoke the parts browser and observe the "Find" box inside the dialog box. Left click on it 
and note that you can type in an actual part number (i.e., 2n2222), or a portion of a part 
number, and the browser will find all such component instances. 

 
8) Close the SpiceNet schematic window (not the outer SpiceNet shell window) by pressing 

the “close” icon in its top right banner.  Remember, you have placed new components, 
perhaps with dangling wires, so select “No” when queried to save changes.  Reopen the 
FlybackTemplateDemo.DWG file.  Select the “AvgSubckt” configuration as you did in 
Step 5.  To its right lies another small white window.  Pull down the “tranAvg 1m” as a 
simulation setup configuration.  

 
To observe how a simulation is setup, under the “Actions” pulldown menu from the 
“SpiceNet” window, select “Simulation Setup” then “Edit.” As an alternative, you could have 
selected the simulation-setup icon in the upper toolbar (shaped like a pencil on top of a 
waveform).  Inside the dialog box, the “Transient” box is checked, so double click on it if you 
want to observe its simulation setup information.  Click on other analysis boxes to see how 
they’re set up, or would be setup. “Analysis” and “Convergence” wizards are selectable near 
the top of the dialog box.  The “Analysis Wizard” is designed to help a user in setting up a 
simulation.  The “Convergence Wizard” is used to guide a user automatically if changing 
SPICE convergence parameters becomes necessary on very complex design.  When finished, 
press “Done” to close the main dialog box.  Press the "Run Simulation" icon from the top 
toolbar, which looks like a person running. An "IsSpice4" window comes to view. A blue 
window inside the IsSpice4 shell provides a thumbnail sketch of real-time marching 
waveforms as the simulation progresses. Other windows provide a simulation output file and 
any error information. Note that a dialog box comes to view titled, "After Simulation Go 
To…" This enables either the schematic, IsSpice4 (simulator), or IntuScope window to be 
active (visible) following design simulations. Select the SpiceNet choice and have the "show 
this dialog after each simulation" box unchecked. You can always change your selection by 
recalling this dialog box from the IsSpice4 window’s "Options" pulldown menu.  Press OK.  
Now left click on the IsSpice4 window’s banner.  If a "Simulation Control" window appears, 
on its banner’s top right corner click the "minimize" button.  Again, click on the IsSpice4 
window banner to make it active.  Press the <CTRL T> keys to rescale the waveforms. To 
have these windows appear in the future as they are positioned now, or any way you 
reposition them, select from the IsSpice4 window’s “Options” menu pulldown, “Save 
Preferences.” 

 
9) Let’s insert a test point at a desired node by left-clicking on the main portion of the 

schematic (not inside a subcircuit). Select the “Parts” pulldown at the top of the window.  
Choose “Test Point” and “Voltage.” This will insert the test point where you left-clicked on 
the schematic.  Next, wire that test point to some portion of the circuit.  Select the 
“Options” pulldown and “Rubberbanding.”  Carefully hold down the left mouse button 
exactly on the test point symbol (horizontal “V”) and drag it a short distance away from its 
present location. Wire connectivity will be maintained. Try other components. 



10) There are several powerful debug features available from the “IsSpice4” window, such as 
schematic-less sweeping of components.  Those are covered in the Getting Started manual.  
Let’s now view waveforms using ICAP/4’s powerful waveform viewer and signal processor 
called, “IntuScope.”  Note that simulation functions, such as “simulation setup,” “IntuScope,” 
etc. are selectable by icon or from the “Action” pulldown of the “IsSpice4,” “SpiceNet” and 
“IntuScope” windows. The "Scope" (IntuScope) icon looks like the crosshairs as found on an 
oscilloscope, and is located on the SpiceNet top toolbar. By the way, the three icons to the 
right of the "Scope" icon turn on or off, and refresh, the design’s DC operating point display 
on the schematic. Try these. If you press refresh after selecting an op pt. display, then click on 
the schematic afterwards, the operating point data will assume colors. Next, click on the 
Scope icon. IntuScope’s "Add Waveform" window comes to view. Inside this, click on any of 
the design node names or components shown in IntuScope’s "Y-Axis" window. Each time 
you select a node or component, click the "Add" box at the lower left corner of this dialog 
box. If you desire the schematic window, IsSpice4 windows, and/or IntuScope windows to be 
viewed simultaneously, this will be addressed in Step 12 below.  Remember, their boxes are 
always accessible from the bottom desktop. 

 
11) Cross probing to view waveforms directly from the schematic is simple. Optionally, first 

delete any waveforms you may have added in IntuScope’s viewing window by clicking on 
any of their names on top and pressing the <delete> key on your keyboard. Select the 
"SpiceNet" box at the bottom of your screen to bring the schematic to view. At the toolbar 
on the far right of the schematic page, select the icon that’s fifth from the top, called 
"Probe." When you want to deselect Probe, select the toolbar’s top icon, or press the <Esc> 
key, or right click the mouse. If you left-click the Probe cursor on any circuit wire or 
component, a corresponding waveform will automatically appear in IntuScope. Try a few.  If 
you cross-probe while holding down the <Shift> key, the waveform will appear directly on 
the schematic. Probe a few entities in the design.  Then (if necessary) select the "IntuScope" 
box at the bottom of your screen to bring it to view to observe the waveforms. If the 
waveform data is too packed to read clearly, select the zoom icon (magnifying glass) in the 
IntuScope window. Hold down the left mouse button and drag a rectangle around the desired 
waveform section. Repeat if necessary. Next, find the “Link All Y” and “Unlink All Y” 
IntuScope icons on its top toolbar (hold the mouse cursor over) and see what effect they 
have on the display.  Try other icons. 
 
There are numerous functions provided in IntuScope’s waveform calculator, all useful for 
instant signal processing. View the many selections from the "Calculator" pulldown menu by 
first left-clicking on a waveform name at the top of the window. Then try some of the functions 
from the calculator menu and see the results instantly display.  If you hold down the left mouse 
button and drag the cursors (labeled “0” and “1”) horizontally across the waveforms, note the 
numerical information change toward the bottom of IntuScope. Finally, in the Add Waveform 
dialog box, you can select different types of simulation runs for waveform display from the 
“Type” box, if more than one analysis type was performed. 
 

12) Finally, you may have had a preference on how various windows come to view each time 
during the above tasks.  Advantageously, there’s a valuable way of customizing this,  
especially useful during repetitive simulation runs and waveform viewing.   

 
First, maximize the inner schematic window.  Then, resize the outer shell window by 
holding down the left mouse button while selecting the outer corner of the SpiceNet 
window. Drag the mouse to shrink the window to about two-thirds the screen size. Next, 
press the "fit to page" icon in the upper schematic toolbar (shape of a blank computer 
screen), or, simply press the <F6> key. This resizes the schematic to fit the window. Now, 
resize the IntuScope window in the same fashion. Next, hold down the left mouse button on 



the SpiceNet window’s top banner, and move the window to exactly where you want it on
the screen.  Repeat this for the IntuScope window. In both windows, select the "Options"
pulldown and select "Save Preferences." Finally, bring the IsSpice4 window to view
selecting its box at the very bottom of the desktop. There are three to four separate 
windows here. First, shrink the size of the blue “simulation status” window so only the 
"Analysis Complete" message shows toward the top. Then, move this window toward th
bottom of the main IsSpice4 window. Minimize the "Simulation Control" window (if it 
appears) by selecting the "minimize" icon in its banner. Reduce the "Errors and Status" 
window to a small size that’s still readable. Reduce the "Output" window to roughly the 
same size as the "Errors and Status window." Finally, shrink the main IsSpice4 window to 
encompass all the other windows you modified. The figure b
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references at any time to change the way these windows 

ill come to view in the future. 
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written with the 
new data, or appended to the same waveform plot, or inserted into a new plot. 

From the "Options" pulldown menu in the IsSpice4 window, select "Save Preferences." 
From this point on, the schematic, IsSpice4, and IntuScope windows will all come to view
in this fashion. You can resave p
w
 
A use for this "save preference" example would be for debugging a design. Example: Double 
click on a component to change its value or parametric data, re-simulate the design by selecting
the simulation icon, then cross-probe a design node or component to bring waveforms to view
in IntuScope. During this procedure, all windows will come to view as prescribed when
"saved preferences." Along these lines, in the IntuScope window, select the "Actions" 
pulldown and choose the "Update" menu. Select any of the last three functions. These enable
new waveform data of previously viewed signals in your waveform plot to be automatically 
updated after a simulation run, simply by pressing the <Ctrl U> keys after a run is complete. 
Depending on which option you selected, previous waveform data will be over



13) Select the “AvgSubckt” configuration in the SpiceNet window.  To its right, select the 
“tranAvg 1m” simulation setup. To automate the change of a component’s value or 
temperature (or design temperature) through a desired range, the "Alter" function located in 
the schematic’s right-hand toolbar can be used. Select the "Alter" icon. Note that once a 
simulation is initially run on the design, only then is the "Alter" function enabled. Place the 
magnifying-glass cursor that appears over C11 (find C11 by pressing <Ctrl F> keys), and 
left-click the mouse.  In the “Alter” dialog box, select the “Linear” circle toward the top.  
Note: if you ever select the “Logarithmic” circle instead of the “Linear” circle, never 
ever type in a “0” for the data!  Hold down the left mouse button and highlight the 
existing value in the “Start” box.  Press the <Backspace> key to delete it.  Type in “1u.”  
Repeat these steps for the “Stop” box to the right and type “20u.”  Type in “5u” in the 
“Step” box.  Next, left-click “vout” in the “Y Axis” box toward the left of the dialog box.  
To its right, left-click the “Add to Plot List” box.  Finally, click on the “Run” box at the 
bottom.  A curve family is automatically produced in IntuScope for the four simulation runs 
representative of the sweep (this will take up to a couple of minutes).  Use IntuScope’s 
Zoom function to see detailed waveform variations for the curve family of V_2.  Quickly 
try selecting any “link,” “tile,” and “cascade” icons in the IntuScope toolbar to see what 
effect they have in displaying the waveforms. Incidentally, ICAP/4 provides two other 
powerful methods of sweeping, one that produces marching waves while simply pressing a 
button to vary a component. Your Getting Started manual covers this feature. 

 
14) Congratulations!  You have now acquired enough basic skill to perform design and debug 

using ICAP/4 demo.  Of course, the power and feature set of ICAP/4 offering at large 
extends far beyond the demo version capabilities.  You can view a wealth of functions from 
the pulldown menus provided at the top of the schematic, simulation and IntuScope 
windows.  To get your feet wet, left-click on the black question mark icon from SpiceNet’s 
toolbar. Then, left click on the “simulation control” icon (light blue square). Review the 
help information that comes to view, because the simulation-control dialog box will be a 
valuable feature as you progress into more advanced design-verification analysis.  Your 
next step in learning more about using ICAP/4 to a fuller potential is to begin using the 
“Getting Started Guide,” which is accessed from SpiceNet’s help pulldown (select PDF 
Manuals). Also, there are movies on the design flow process under the Help pulldown; 
select "Tutorial Movies." 

 
15) Please provide your feedback on this tutorial by emailing Intusoft at: rmktg@intusoft.com 
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